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VETLINKPRO SHORTCUT ICONS

The standard icons for the VetlinkPRO shortcuts are listed below.

o

M
VetlinkPRO Play  VetlinkPRO Play
Setup

VetlinkPRO VetlinkPRO

Setup

OVERVIEW OF THE VETLINKPRO INTERFACE

The VetlinkPRO screen can be broken down into several sections that show the user information
about their VetlinkPRO session as well as providing an interface for day to day functionality. The
main sections can be broken down to the Title Bar, File Menu, Notification Toolbar, Main Button
Menu, Work area and the common toolbar. This chapter will describe each section in detail.
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Title Bar

VETLINK User = VL2TEST Profile = DEFAULT Role = Default Staff = State = Normal Idle At = 15:02:50

The Title Bar displays six important pieces of information; the User, Profile, Role, Staff ID, State
and ldle time.

User The User is created from the windows user profile that you log
on with. Some setup options in VetlinkPRO are saved against
this user profile. Therefore each user can behave slightly
differently than the next.

Profile The Profile is a group that the User belongs to. Each Profile
has settings that are shared by each member in that group.
These mainly apply to the printer settings.

For example, you may have two computers and a printer at
reception, as well as two computers and a printer in the back
office. The front two computers may use a Profile called
‘Front’ which directs printing to the printer at ‘Reception’. The
back two computers may use a Profile called ‘Back’ which
directs printing to the printer at the back office. If the printer is
replaced at Reception, the printer settings in VetlinkPRO only
need to be updated in one location which will update all two
computers automatically.

Role VetlinkPRO has been designed so an administrator can assign
users to a Role. Each Role will be able to access certain
areas of the application as deterimined by the administrator.
For example, Junior Staff members can be excluded from
accessing financial reports.

Staff ID The Staff is the current staff ID logged into VetlinkPRO
State
Idle At The Idle time is when the current staff member will be logged

out of VetlinkPRO if the computer is left idle.
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File Menu
VETLINK User = VL2TEST Profile = DEFAULT Role :
Jump To Spell Utilities Options Log In/Out.. Lab Reports Window
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= How to Use Help
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= Tips & Hints
==
Bill CFL Ref = 8401
= Dowload TeamViewer
Diary About...
=
Arrivals

The file menu provides access to some of the less commonly used areas of VetlinkPRO. To open a
menu single left click on the menu name and a drop down list will open. Depending on the window
you currently have open in the Work Area, the menus available may change. For example, when a
client record is open an ‘Actions’ menu will appear.

Jump To The ‘Jump To’ file menu is used for fast keyboard navigation to the
areas listed in the ‘Main Button Menu’. For example, pressing
‘ALT+J’ (to activate the Jump to menu) then ‘B’ will take you to the
billing menu.

Utilities The ‘Utilities’ file menu is where you will find the program utilities.
One of the most important utilities is the End of Period utility; this is
where the End of Day, End of Month and End of Year functions are

located.

Options The ‘Options’ file menu is where the setup options for the application
are found.

Log In/ The ‘Log in/Out” menu option will open the Password Control

Out window. This enables you to log in or out of areas of the program that
have been restricted.

Lab The ‘Lab Reports’ menu will show all new incoming lab reports

Reports emailed from a Lab or sent from an IDEXX workstation.

Window The ‘Window’ menu option is where you can arrange the windows

you have open by tiling, cascading them or even closing them en
masse. This menu will also list all the windows you have open in
VetlinkPRO at any one time.

Help The ‘Help’ menu lists all functionality that will assist users to run
VetlinkPRO.

Navigate The ‘Navigate’ menu option is used to navigate through records. The
Navigate window is only available when certain windows are open, for
example the Arrivals window.

Actions The ‘Actions’ menu will only appear when certain windows are open
and active. The ‘Actions’ menu will only display options that are
relevant to the current window that is open.
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Status Bar

The Status Bar provides a go-to area for all alerts and things that need your attention. The Status
Bar has now been cut into three sections and is displayed at the top by default.

= [l v @ B @

Left - Icons:

(Notification lcons)

OBE TS0 Vres 10 Mosior | S Masier | 15092021 24401pm

This shows the status of some important portions of the

other users.

Middle - Text: This shows messages for important events.

Right - Panels:

Notification Icons

application as they change in the background or due to

This shows things like current date and time, current store

and till etc. Clicking on a panel allows you to change that

item.

The Status Bar has seven icons that will quickly let you know if something needs attention in
VetlinkPRO. By default the icons are Yellow, when one of them requires your attention they change
colour to Red and start blinking.

Clicking on the icon will view the information needing attention and also signals to the program that
you are attending to it so the icon will stop flashing and turn back to Yellow, letting other staff
members know that it is being taken care of. The icon will turn back to red and start blinking again if

anything new needs

BTy
v @
El=
[d

attention.

Recurring invoices that need posting.

A new Lab Report has arrived by email and needs to be endorsed
Stock Take is currently in progress at your store.

A new Email message has arrived. Not implemented.

A new SMS reply has arrived.

Background has posted a serious error.

A transaction is in error, this includes bills, invoices, documents etc.

Indicates whether the Background Processor is running.
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Status Bar Customisation

The status bar can be customised to your own preference, to customise it simply right-click any icon
on the bar and it will bring up the setup menu. Please note that these settings are saved for that
workstation only.

Position: Defines where the Status Bar will reside, the options are top
and bottom.

Appearance: Controls the style of the Status Bar.

Colour Determines the colour of the Status Bar. Note the Icon Panel

Scheme: becomes grey for some of the colours. This is because the

icons do not stand out in those Colour Schemes.

Icon Blinking: This controls how fast the icons will blink when requiring
attention. If you are using Terminal Services and find that the
blinking slows down the responsiveness of the screen, then you
should turn the blinking off.

Icon Refresh: This determines how often the VetlinkPRO will check to see if
anything new requires attention. It is strongly recommended that
you DO NOT turn off the update unless there are other users
that are dedicated to handling the icons. The recommended
setting is every 3 seconds.
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Main Button Menu
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Default Bill Diary || Arrivals || Hotel Client || Patient || Ac.Hist Staff || Product || Credtrs BAM Reports || Hiouts |[Int Docs

The Main Button Toolbar is where users can access the most commonly used functions in the

system. Each buttons function is listed in the table below.

The ‘Padlock’ button is your login icon; it is used to access areas
that have been set up by management as restricted, or to perform
special functions in the system. The button changes its appearance
once someone has logged in. The characters at the top of the
button refer to the user who is logged in, while the characters on the
bottom of the button refer to the access level that has been granted
to that user.

The ‘Billing’ menu is used to process financial transactions for
clients. (For more information on the billing menu see chapter on
Billing)

The ‘Diary’ menu button is used to access the appointment book /
Diary where you can create, view or edit appointments for clients.

The ‘Arrivals’ menu button is used to access the client arrivals
screen which shows clients who are due, who have arrived and for
how long clients have been waiting.

The ‘Hotel’ button is used to access the Hotel diary. This is an
optional module. If you wish to make this module active, please
contact CFL at sales@cfl.co.nz.

The ‘Client” menu button is used to access client records. The client
record is where all client related information is found. (For more
information on the client menu see the chapter on client
management).

The ‘Animal’ menu button is used to access animal records. The
animal record is where all animal related information is found. (For
more information on the animal menu see the chapter on animal
management).

The ‘Ac. Hist’ (Account History) menu button is used for looking up
all the transaction history. The account history screen contains
every client transaction ever created in the system including all bills
and refunds.

The ‘Staff’ menu button is used to access staff records. The staff
records include personal details, contact information, rosters and
sales and purchase history.
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The ‘Product’ button is used to access the goods and services file.
From the product screen you can add and edit products and
services.

The ‘Creditors’ menu gives access to the ordering / invoicing
module, this is where most inventory control is handled.

The ‘G.Ldgr’ (General Ledger) menu button is used to access the
general ledger module. This is an optional module. If you wish to
make this module active, please contact CFL at sales@cfl.co.nz

The ‘Reports’ menu button is used to access the reporting and
marketing module.

The ‘H/outs’ button is used to access any documents you have
created and stored in the handouts folder. For example, you can
store any information that you need to provide to clients such as
post-surgery care sheets or advice on caring for an animal with a
particular disease.

The ‘Int Doc’ button is used to access any documents you have
created and stored in the internal documents folder. For example,
any instructions or information that is used internally.

The ‘Orientation’ button changes the position of the ‘Main Button
Toolbar’. By default the toolbar will display vertically along the left
hand side of the page, clicking the ‘Orientation’ button will change
the position to horizontal acrross the top of the page.
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Customising the Main Button Menu

You can customise which buttons you want to display on the Main Button Toolbar from Options ->
Setup -> Misc -> At Startup -> Show Buttons in Tool Bar. From here you just need to tick the
buttons that you wish to appear in the menu toolbar. These settings are user based so each user
can have different buttons showing on the toolbar. This is great for removing clutter from the toolbar
restricting access to areas of the application. E.g. The computer in the storage room might solely be
used for receipting and ordering stock and staff members in this area may not have the authority to
make bills. In this scenario you can remove buttons, like the bills button, that are not applicable to
operations in this area.

B
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My PC My Settings Profile
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[ Using Touch Screen Screen at Startup | None - L U] R
v Use Modern Look on Forms [~ Centre Mouse on Dialogs ¥ LogIn
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Colours on Grids | Extra Light | v Arrivals
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Work Area

The ‘Work Area’ is where windows are opened and the day to day procedures performed in
VetlinkPRO take place.

The Work Area uses MDI technology. MDI (Multiple Document Interface), technology allows the
user to work on an unlimited number of windows at the same time on screen. Unlike legacy
applications where you have to close a task window to perform another task or have a limit of open
windows, this technology allows virtually an unlimited number of multiple windows to be open at the
same time on-screen.

For example, you could be viewing an animal’s history when another client calls and asks when
their next appointment is. With MDI technology you can leave the animal history open and also open
the diary to check for the client’s next appointment. Once the appointment has been you can close
the diary the animal history will still be in the position you left it.

(<] VETLINK User = VL2TEST Profile = DEFAULT Role = Default Staff = State = Normal Idle At = 13:34:57 | =1o
Navigate Actions JumpTo Spell Utilities Options LogIn/Out.. LabReports Window Help
= 1l v © 5 @ 0 @ |
=
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TIP: The ‘Windows’ menu has many functions that help manage the
work area when multiple windows are open. It lists all current windows
that are open as well as providing an option to close all windows at
once if the work space has become too cluttered.
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Common Toolbar

The common toolbar is usually displayed on product, client, animal and supplier records as well as
bills, creditor orders, invoices and payments. Each type of record will display different buttons that
provide different functionality to that record; the common buttons are displayed below.

I | 4 | > | 2 |:mB',.r_Number

| = | @ | e | # | =] & |Adions RN

om Cln_By_Mumber

)

Actions

AF3: Exit

Scroll Buttons: These buttons enable you to scroll from record to
record in the direction shown by the arrow. The arrows with the
lines on the end will scroll directly to the first and last records
respectively. The scroll order is based on the scroll mode as
outlined below.

Scroll Mode: This is the order in which you are currently scrolling
through the database. By clicking on this button you can change
the scroll mode to a different order. For example on the client
record you can scroll through the records in Category 1 or 2 order,
company name order, first or last name order, client number or
user code number order.

Search: This button will open a new search window to find another
record

Print: This button will open a Print Menu that allows you to print
forms and reports specific to this record

Refresh: This button refreshes the record on your screen, to show
any changes if someone else has modified the record while you
are viewing it.

Add: This button will open a new record, ready for you to create a
new record quickly.

Not Applicable.

Edit: This button will allow you to edit or make changes to the
record that you have on your screen. This is controlled by a setup
options, most clinics will be able to edit records without clicking on
this button.

Actions: This button brings up a list of extra functions that are
unique to the record that you are opening.

Exit: This button will close the window that you have open.
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ACTIVITY LOG

An Activity log is available on most records in VetlinkPRO. The activity log will record events so you
can go back and see an audit trail of why the record has changed. For example if a client record has
been made inactive you can open the activity log for the client and see the date, time, computer,
etc... that made the change. The activity log is available by going to a record then selecting the
Actions button then View Activity log. From an appointment you can right click on the appointment
and select View Activity log.

a (E=N R
Type Diary ~|  Entity Type |Al [:] From [16/10/2018 - \1200 00AM - ™ Show Background Changes
Staft AL -] Entiy Name | To [16/11/2018 || 93s29am = Search

Type Entity Name Mst_Ref Action What 0Old Value New Value When Who WinUser Machine  App Branch  Company Ref Number -
Diary Small Animal #1/28028 Medified Dry_Num ‘Web Appointment Small Animal 16/11/2018 3:34:50 AM *sup* KIERAN KD Main Applic: 1 1 10000012253
Diary Small Animal #1/28028 Modified Date 9011/2018 16/11/2018 16/11/2018 9:34:50 AM *sup* KIERAN KD Main Applici 1 1 10000012254
Diary Small Animal #1/28028 Modified Start 8:00 AM 10:00 AM 16/11/2018 9:34:50 AM *SuUP* KIERAN KD Main Applic: 1 1 10000012255
Diary Small Animal #1/28028 Modified Finish 815AM 10:15AM 16/11/2018 9:34:50 AM *sup* KIERAN KD Main Applic 1 1 10000012256
Diary Small Animal #1/28028 Modified Finish 10:15 AM 10:30 AM 16/11/2018 9:34:56 AM *sup* KIERAN KD Main Applic. 1 1 10000012257
Diary Holding Tank #1/28028 Modified Dry_Num Small Animal Holding Tank 16/11/2018 9:35:03 AM *SUPT KIERAN KD Main Applic 1 1 10000012258
Diary Small Animal #1/28028 Modified Dry_Num Holding Tank Small Animal 16/11/2018 9.35:07 AM *SUpP* KIERAN KD Main Applic 1 1 10000012259
Diary Small Animal #1/28028 Modified Date 16/11/2018 1711142018 16/11/2018 9:35:07 AM *supr KIERAN KD Main Applic 1 1 10000012260
Diary Small Animal #1/28028 Modified Start 10:00 AM 11:00 AM 16/11/2018 9.35:07 AM *SUP* KIERAN KD Main Applic 1 1 10000012261

P Diary Small Animal #1/28028 Madified Finish 10:30 AM 11:30AM 16/11/2018 9:35:07 AM *SuUP* KIERAN KD Main Applici 1 1 10000012262

5 v

Activity Log for appointment changes

Type |EB <] Enity Type [Al [] From [167102018 | [120000am = I~ Show Background Changes

Staft ALL* ~|  Eniity Name | To  [16/11/2018 = [ 93sasam = Search

Type Entity Name Mst_Ref Action What 0ld Value New Value When Who WinUser Machine  App Branch  Company Ref Number ~
P BillMain  TaxRecsipt #1/2085 Added Type TaxReceipt  16/11/201833706AM  "SUP* KERAN KD Main Applic: 1 1 10000012270

BilMain  TaxReceipt #1/2085 Added Cin_Ref John Smith 16/11/2018 93706 AM_ *SUP* KERAN KD Main Applic; 1 1 10000012271

Bill tems For Chase #1/2085 Added Itm_Qty 0.00000 16/11/2018 9:37.07 AM *SUP* KIERAN KD Main Applic. 1 1 10000012272

BilMain  TaxReceipt #1/2085 Modfied  Acc_State Open InDiary 16/11/2018 93708 AM  *SUP* KERAN KD Main Applic 1 1 10000012273

Bilkems  Advaniage Per Vial Dog »25k # 1/2085 Added ttm_Gty 100000 16/11/2018 93749 AM  *SUP* KERAN KD Main Applic: 1 1 10000012275

Billltems  Advantage Dogs over25kg  #1/2085 Added Itm_Qty 0.25000 16/11/2018 9:37:50 AM *SUP* KIERAN KD Main Applic. 1 1 10000012276

Bilklems  Dispensing Fee 5 #1/2085 Added tm_Qty 100000 16/11/201893760AM  "SUP* KERAN KD Main Applic 1 1 10000012277

Bilkems  Advaniage Per Vial Dog 25k # 1/2085 Modfied  hm_Qty 100000 200000 16/11/2018 93756 AM_ *SUP* KERAN KD Main Applic: 1 1 10000012278

Billltems  Advantage Per Vial Dog »25k # 1/2085 Modified Itm_Sell 9.370 18.740 16/11/2018 9:37:56 AM *SUP* KIERAN KD Main Applic: 1 1 10000012279

Bilkems  Advaniage Per Vial Dog >25k # 1/2085 Modified  lm_Sell 18740 18750 16/11/2018 93756 AM  "SUP* KERAN KD Main Applic 1 1 10000012280

Billems  Advaniage Dogs over25kg #1/2085 Modified  lm_Qty 025000 050000 16/11/2018 93756 AM_ "SUP* KERAN KD Main Applic; 1 1 10000012281

Bilkems  Advantage Dogs over25kg #1/2085 Modfied  hm_Sell 17010 17020 16/11/2018 93756 AM *SUP* KERAN KD Main Applic; 1 1 10000012282

Bill tems Dispensing Fee 5 #1/2085 Modified Itm_Qty 1.00000 200000 16/11/2018 9:37:56 AM *SUP* KIERAN KD Main Applic. 1 1 10000012283

Bilklems  Advaniage Dogs over25kg #1/2085 Modified  lm_Sell 17.020 17010 16/11/2018 93766 AM  "SUP* KERAN KD Main Applic 1 1 10000012284

Bilkems  CatHospital #1/2085 Added ttm_Gty 100000 16/11/2018 93818 AM  *SUP* KERAN KD Main Applic; 1 1 10000012285

Bill tems Cat Hospital #1/2085 Deleted Itm_Qty 1.00000 16/11/2018 9:38:22 AM *SUP* KIERAN KD Main Applic. 1 1 10000012286

%

Activity Log for bill changes
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